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CHAPTER 1 
GETTING STARTED WITH GIMP 

  

Objectives: 

●​Start GIMP 
●​Learn how to open and save an image 
●​Examine the GIMP window 
●​Close a file and exit GIMP 
●​Learn design principles and copyright rules  

3 



Using GIMP 
GIMP is an image-editing program that lets you create and modify digital images. 
GIMP stands for Graphic Image Manipulation Program. A digital image is a picture in 
electronic form. Using GIMP you can create original artwork, manipulate color images, 
and retouch photographs. A digital image may also be referred to as a file, document, 
graphic, picture, or image. In addition, GIMP is practical for anyone who wants to 
enhance existing artwork or create new master pieces. For example you can restore 
damaged areas within an image, combine images, and create graphics and special 
effects for the web. 

QUICK TIP: In GIMP, a digital image may be referred to as a file, document, graphic, 
picture, or image. 

Understanding Sources 
GIMP allows you to work with images from a variety of sources. You can create your 
own original artwork in GIMP, use images downloaded from the web, or use images 
that have been scanned or created using a digital camera. Whether you create GIMP 
images to print in high resolution or optimize them for multimedia presentations, 
web-based functions, or animation projects, GIMP is a powerful tool for communicating 
your ideas visually.  
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Lesson 1 
Start GIMP 

  

Defining Image-Editing Software 
GIMP is an image-editing program. An image-editing program allows you to 
manipulate graphic images so that they can be posted on websites or reproduced by 
professional printers using full-color processes. Using panels, tools, menus, and a 
variety of techniques, you can modify a GIMP image by rotating it, resizing it, changing 
its colors, or adding text to it. You can also use GIMP to create and open different kinds 
of file formats, which enables you to create your own images, import them from a 
digital camera or scanner, or use files (in other formats) from outside sources. Table1 
lists some of the graphics file formats that GIMP can open and create. 

Understanding Images 
Every image is made up of very small squares which are called pixels, and each pixel 
represents a color or shade. Pixels within an image can be added, deleted, or modified. 

QUICK TIP: GIMP files can become quite large. After a file is complete, you might 
want to flatten it, an irreversible process that combines all layers and reduces the file 
size. 

Using GIMP features 
GIMP includes many tools that you can use to manipulate images and text. Within an 
image, you can add new items and modify existing elements, change colors, and draw 
shapes. For example, using the Free Select Tool, you can outline a section of an image 
and drag the section onto another area of the image. You can also isolate a foreground 
or background image. You can extract all or part of a complex image from nearly any 
background and use it elsewhere. 
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QUICK TIP: You can create logos in GIMP. A logo is a distinctive image that you can 
create by combining symbols, shapes, colors, and text. Logos give graphic identity to 
organizations such as corporations, universities, and retail stores. 

You can also create and format text, called type, using the Text Tool in GIMP. You can 
apply a variety of special effects to type; for example, you can change the appearance 
of type and increase or decrease the distance between characters. You can also edit 
type after it has been created and formatted. 

QUICK TIP: GIMP records each change you make to an image on the History panel. 
You can undo or redo a recorded action as necessary. GIMP records actions for the 
current session only; it discards actions when the program closes.  

  

TABLE 1: SOME SUPPORTED GRAPHIC FILE FORMATS 

File Format Filename 
Extension 

File Format Filename 
Extension 

3D Studio .3ds Photoshop PDF .pdf 

Bitmap .bmp PICT File .pct, .pic, .pict 

Cineon .cin Pixar .pxr 

Dicom .dcm Open EXR .exr 

Flash 3D .fl3 QuickTime .mov, .mp4 

Filmstrip .flm Radiance .hdr, .rgbe, 
.xyze 
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GIMP .xcf Tagged Image 
Format 

.tif, .tiff 

Google Earth .kmz RAW Varies 

Graphics 
Interchange 

Format 

.gif Scitex CT .sct 

JPEG Picture 
Format 

.jpg, .jpe, .jpeg Tagged Image 
Format 

.tif, .tiff 

PC Paintbrush .pcx Targa .tga, .vda 

Photoshop .psd U3D .u3d 

Photoshop 
Encapsulated 

PostScript 

.eps Wavefront .obj 
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Starting GIMP and Creating a File 
When you start GIMP, the computer displays a splash screen, a window that contains 
information about the program and then the GIMP window opens. See Figure 1. 

Figure 1 Splash Screen 

   

After the splash screen is done loading GIMP a window with a blank screen in which 
you can create a file from scratch opens. See Figure 2. 

Figure 2 Opening Screen in GIMP 
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You use the Create a New Image dialog box to create a file. You can also use the 
Create a New Image dialog box to set the size of the image you’re about to create by 
typing dimensions in the Width and Height text boxes. See Figure 3 

Figure 3 Create a New Image Dialog Box 

   
Step-by-Step 1.1 

Start GIMP 

1. Click the GIMP icon on your desktop 

2.  Click File on the Menu bar, the click New to open the Create a New Image dialog 

     box. 

3.    Make sure your Units is set to pixels 

4.    Double-click the number in the Width text box, type 500. 

5.    Double-click the number in the Height text box, type 400 
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6.    Specify a resolution of 72 pixels/inch. 

7.     Click OK  
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Lesson 2 
EXAMINE: THE GIMP WINDOW 

  

Learning About the Workspace 
The GIMP Workspace is the area within the GIMP program window that includes the 
entire window, from the command menus at the top of your screen to the both sides of 
your window. See Figure 4. 

Figure 4 Workspace 
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In GIMP the area containing the GIMP commands is called the Menu Bar. The filename 
of the open unnamed file is Untitled, because it has not been named. The Menu bar 
also contains the Close button and the Minimize/Maximize and Resort buttons. 

You can choose a menu command by clicking it or by pressing [Alt}, and then clicking 
the underlined letter in the menu name. Some commands display shortcut keys on the 
right side of the menu. Shortcut keys provide an alternative way to activate menu 
commands. Some commands might appear dimmed, which means they are not 
currently available. 

Finding Tools Everywhere 
The Toolbox panel contains tools associated with frequently used GIMP commands. 
The face of a tool contains a graphical representation of its function; for example, the 
Zoom tool shows a magnifying glass. You can place the pointer over each tool to 
display a tool tip, which tells you the name or function of that tool. 

The Tool Options panel, located below the Toolbox panel, displays the current 
settings for the selected tool. For example, when you click the Type tool, the default 
font and font size appear in the Tool Options panel, which can be changed if desired. 
You can move the Tool Options panel anywhere in the workspace for easier access. 

Panels are small windows used to verify settings and modify images. A collection of 
panels in a vertical orientation (typically) is called a dock. Panels can be separated and 
moved anywhere in the workspace by dragging their tabs to new locations. You can 
Dock a panel in or under other panels so you can keep that panel in place with other 
panels. Panels can be separated and docked anywhere in the workspace by dragging 
their tabs to new locations. You can dock or undock a panel by dragging its tab in or 
out of a dock. As you move a panel within the dock, you’ll see a blue highlighted drop 
zone.  A Drop Zone is an area where you can move a panel. Each panel contains a 
menu that you can view by clicking the configure button in its upper-right corner. 

When images are displayed the Status Bar is located at the bottom of the program 
window. The Status Bar displays information, such as file size of the active window. 

Rulers can help you precisely measure and position an object in the workspace. 
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Using Tool Shortcut Keys 
Each tool has a corresponding shortcut key. For example, the shortcut key for the Type 
tool is T. After you know a tool’s shortcut key, you can select the tool on the Toolbox 
panel by pressing its shortcut key. 

Customizing Your Environment 
GIMP makes it easy for you to position elements just where you want them. If you 
move elements around to make your environment more convenient, you can always 
return your workspace to its original appearance by resetting the default panel 
locations. 

You can temporary change the color of your workspace by clicking the View menu and 
clicking on the Padding command.  Here you can choose one of four color themes. You 
can make a permanent color change by going to the Edit menu and clicking the 
Preference command. In the Preference dialog box click on Appearance and it is within 
this section that you can make your workspace color permanent. 

Using Full Screen Mode 
By default, GIMP displays images in consolidated windows, although you can change 
this on a permanent or temporary basis. This means that each image is displayed 
within its own window. There are two modes for viewing: Standard Screen Mode – 
which shows you all of your image, title bar, menu, and tools. Full Screen Mode – 
which shows only your image and the menu bar. You toggle between these two views 
by pressing F11.  
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Step-by-Step 1.2 
Select a tool 

1. Hover over the Free Select tool on the Toolbox panel. Note that the shortcut key is 

    F, located at the end of the screen tip in bold. 

2.  Click on some other tools in the Toolbox panel and notice how the Tool Options 

    panel changes with each tool that you click on. 

Change the default display and theme color 

1.  Click Edit on the Menu bar, click Preferences, then click Appearance 

2.  Next to the option Canvas Padding Mode, click the arrow and choose Light Check 

    Color 

3.  Click OK 

4.  Right Click anywhere in the workspace, point to View, Point to Padding Color, 

    choose From Theme 

Show and hide panels 

1.  Click Window on the Menu bar, point to Dockable Dialogs, choose Colors 

The Colors panel is now a floating panel, meaning that it is not locked/docked into 

another panel yet. 

2.  Click on the FG/BG Color Tab, Drag the tab over and above the Tool Options 
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    Panel, when you see the blue line drop the panel. 

The Color panel is now locked above the Tool Options Panel. 

3. Click on the FG/BG Color tab, Drag the tab away from the panel and drop it into 

    the workspace. 

The Color Panel is now a floating panel again. 

4.  Click on the FG/BG Color tab, Drag the tab into the Tools Options panel and drop 

    it right next to the Tools Options tab. 

The Color panel is now locked/docked with the Tools Options panel 

5.  Click on the FG/BG Color tab, Drag the tab into the workspace 

6.  Click on the Red X in the top right corner of the Color panel  
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LESSON 3 
LEARN HOW TO OPEN AND SAVE AN IMAGE 

  

Opening and Saving Files 
GIMP provides several options for opening and saving a file. Often, the project you’re 
working on determines the techniques you use for opening and saving files. For 
example, you might want to preserve the original version of a file while you modify a 
copy. You can open a file, and then immediately save it with a different filename, as 
well as open and save files in many different file formats. When working with graphic 
images, you can open a GIMP file that has been saved as a bitmap (.bmp) file, and 
then save it as a JPEG (.jpeg) file to use on a web page. 

Customizing How You Open Files 
You can customize how you open your files by setting preferences. Preferences are 
options you can set that are based on your work habits. For example, you can use the 
Open Recent command on the File menu to instantly locate and open the files that you 
recently worked on, or you can allow others to preview your files as thumbnails. Figure 
5 shows the GIMP Preferences dialog box options for handling your files. 
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Figure 5 Preferences Dialog Box 

  

 Using Save As Versus Save 
Sometimes it’s more efficient to create a new image by modifying an existing one, 
especially if it contains elements and special effects that you want to use again. The 
Save As command on the File menu (in GIMP) creates a copy of the file, prompts you 
to give the duplicate file a new name, and then displays the new filename in the 
image’s title bar. You use the Save As command to name an unnamed file or to save 
an existing file with a new name. For example, throughout this book, you will be 
instructed to open your Data Files with new names keeps the original files intact in 
case you have to start the lesson over again or you want to repeat an exercise. When 
you use the Save command, you save the changes you made to the open file.  
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Getting images into GIMP 
There are a zillion digital cameras available in the marketplace, and each brand is a 
little different, but you can still import your images by connecting the camera to the 
computer using the camera’s USB cable. Turn the camera on and once your computer 
recognizes the camera, open the program computer and double-click on the camera 
device. Then navigate to the camera’s picture folder to start saving your pictures. This 
process can also be used for an SD card or a flash drive. 

Resizing an Image 
You may have created the perfect image, but the size may not be correct for your print 
format. Document size is a combination of the printed dimensions and pixel resolution. 
An image designed for a website, for example, might be too small for an image that will 
be printed in a newsletter. You can easily resize an image using the Scale Image 
command in the Image menu. To use this feature, open the file you want to resize, click 
Image on the Menu Bar, and then click Scale Image. The Scale Image dialog box, 
Show in Figure 6, opens. By changing the dimensions in the text boxes, you’ll have 
you resized in no time. The canvas size, which is the full editable area of an image, 
can be increased or decreased using the Canvas Size command on the Image Menu. 
Decreasing an image’s size crops the image whereas increasing the image’s size adds 
to the background. 

Figure 6 Scale Image Dialog Box 
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Step Step-by-Step 1.3 
Open a file using the Menu bar 

1. Click File on the Menu bar, then click Open 

2.  Navigate to your Student Key/Student Files/GIMP Ch. 1/ 1-1, click Open 

3.  Maximize your screen 

4.  Click File on the Menu bar, then click Open 

5.  Navigate to your Student Key/Student Files/GIMP Ch. 1/1-2, click Open 

6.  Go to the taskbar and hover over the GIMP Icon, when the preview screens pop up 

    click on 1-2 

7.  Maximize your screen 

Change between document views 

8. Click Window on the Menu bar, click on 1-1 

Use the Save As Command 

9.  Verify that 1-1 is active 

10. Click File on the Menu bar, click Save As, then compare your Save As dialog box 

       to Figure 1-6 

11. Navigate to your Student Key/GIMP/Ch. 1 
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12.  In File Name type Friends, then click Save 
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LESSON 4 
CLOSE A FILE AND EXIT GIMP 

  

Concluding Your Work Session 
At the end of your work session, you might have opened several files; you now need to 
decide which ones you want to save. 

Closing Versus Exiting 
When you are finished working on an image, you need to save and close it. You can 
close one file at a time, or close all open files at the same time by exiting the program. 
Closing a file leave GIMP open, which allows you to open or create another file. Exiting 
GIMP closes the file, closes GIMP, and returns you to the desktop, where you can 
choose to open another program or shut down the computer. GIMP will prompt you to 
save any changes before it closes the files. If you do not modify a new or existing file, 
GIMP will close it automatically when you exit. 

Step Step-by-Step 1.4 
Open a file using the Menu bar 

1. Click File on the Menu bar, click on Close View at the bottom of the menu 

If asked to save your work, click Yes. The Friends file closes and 1-2 is now in full view. 

2. Click File on the Menu bar, click on Close All at the bottom of the menu 

1-2 closes and a blank window is now open in GIMP 

3. Click File on the Menu bar, click Quit 
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GIMP closes completely 
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LESSON 5 
LEARN ABOUT DESIGN PRINCIPLES AND COPYRIGHT 

RULES 

  

Print Design vs. Web Design 
Who’s going to be viewing your images, and how? Will your image be printed in a lot of 
5000, or will it be viewed on a monitor? Does it matter? When you think about it, the 
goals of print designers are quite different from those who design for the web. Table 2 
illustrates some of the differences between these two art forms. 

Table 2: DIFFERENCES BETWEEN PRINT AND WEB DESIGN 

PRINT WEB 

Mass-produced product that will all be 
identical and can be held in someone’s 
hand. 

Will be viewed on monitors of different 
size and resolution, with varying colors. 

Designed for a limited size and area 
measured in inches. 

Designed for a flexible web page 
measured in pixels 

You want to hold the reader’s attention 
long to deliver the message: a passive 
experience. 

You want the reader to stay as long as 
possible in your website and click links 
that delve deeper: an active 
experience. 

Output is permanent and stable. Output varies with user’s hardware and 
software and content can evolve. 
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Image Composition 101 
What makes one design merely okay and another terrific? While any such judgement is 
subjective, there are some rules governing image composition. It goes without saying 
that, as the artist, you have a message you’re trying to deliver or something you’re 
trying to say to the viewer. This is true whether the medium is oil painting, photography, 
or GIMP imagery. 

Elements under your control in your composition are tone, sharpness, scale, and 
arrangement. (You may see these items classified differently elsewhere, but they 
amount to the same concepts). 

●​ Tone is the brightness and contrast within an image. By using light and shadows 
you can shift the focus of the viewer’s eye and control the mood. 

●​ Sharpness is used to direct the viewer’s eye to a specific area of an image. 
●​ Scale is the size relationship of objects to one another. 
●​ Arrangement is how objects are positioned in space, relative to one another. 

Are objects in your image contributing to clarity or clutter? Are similarly-sized objects 
confusing the viewer? Would blurring one area of an image change the viewer’s focus? 
These are the tools you have to influence your artistic expression. Make sure the 
viewer understands what you want seen. 

Arranging Elements 
The appearance of elements in an image is important, but of equal importance is the 
way in which the elements are arranged. The components of any image should form a 
cohesive unit so that the reader is unaware of all the different parts, yet influenced by 
the way they work together or emphasize a message or reveal information. For 
example, if a large image is used, it should be easy for the reader to connect the image 
with any descriptive text. There should be an easily understood connection between 
the text and the artwork, and the reader should be able to seamlessly connect them. 

 

  

24 



In a newsletter, for example, it makes sense to organize text in a columnar fashion, but 
would you want snaking columns in a web page? Probably not. You wouldn’t want to 
be scrolling up and down to read all the columnar text. At the very least, good web 
design has to consider the following items: 

●​ Layout, navigation, and flow 
●​ Interactivity as a design element 
●​ Imagery and text as content 
●​ Scrolling and linking 

Overcoming the Fear of White Space 
One design element that is often overlooked is white space. It’s there on every page, 
and it doesn’t seem to be doing much, does it? Take a look at a typical page in this 
book. Is every inch of space filled with either text or graphics? Of course not. If it were, 
the page would be impossible to read and would be horribly complex and ugly. The 
best example of the use of white space is the margins surrounding a page. This white 
space acts as a visual barrier-a resting place for the eyes. Without white space, the 
words on a page would crowd into each other, and the effect would be a cramped, 
cluttered, and hard-to-read page. Thoughtful use of white space makes it possible for 
you to guide the reader’s eye from one location on the page to another. For many, one 
of the first design hurdles that must be overcome is the irresistible urge to put too much 
stuff on a page. When you are new to design, you may want to fill each page 
completely. Remember, less is more. Think of white space as a beautiful frame setting 
off an equally beautiful image. 

Balancing Objects 
The optical center of an image or a page occurs approximately three-eighths from the 
top of the page and is the point around which objects on the page are balanced. Once 
the optical center is located, objects can be positioned around it. A page can have a 
symmetrical or asymmetrical balance relative to an imaginary vertical line in the center 
of the page. In a symmetrical balance, objects are placed equally on either side of the 
vertical line. This type of layout tends toward a restful, formal design. In an 
asymmetrical balance, objects are placed unequally relative to the vertical line. 
Asymmetrical balance uses white space to balance the positioned objects and is more 
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dynamic and informal. A page with objects arranged asymmetrically tends to provide 
more visual interest because it is more surprising in appearance. 

Considering Ethical Implications 
Because GIMP makes it so easy for you to make so many dramatic changes to 
images, you should consider the ethical ramifications and implications of altering 
images. Is it proper or appropriate to alter an image just because you have the 
technical expertise to do so? Are there any legal responsibilities or liabilities involved in 
making these alterations? Because the general public is more aware about the topic of 
intellectual property (an image or idea that is owned and retained by legal control) 
with the increased availability of information and content, you should make sure you 
have the legal right to alter an image, especially if you plan on displaying or distributing 
the image to others. Know who retains the rights to an image, and if necessary, make 
sure you have written permission for its use, alteration, and or distribution. Not taking 
these precautions could be costly. 

QUICK TIP: Framing means to center object(s) or interest in the foreground, which 
gives an image a feeling of depth. Depth of field is a characteristic of a camera that 
can be used to enhance the image composition, and means the sharp area 
surrounding the point of focus. The field of view includes the content you want to 
include in an image and the angle you choose to shoot from. 

Understanding Copyright Terms 
As you become more adept using GIMP, you’ll most likely obtain images from sources 
other than your own imagination and camera. It’s of the utmost importance that you 
understand the legal and moral implications of using someone else’s work. This 
means, among other things, that you have permission (verbal, or preferably, written) to 
use any part of the image, and that you understand terms such as copyright, fair use 
doctrine, intellectual property, and derivative works. 

A copyright is protection extended to an author or creator of original work, which gives 
them the exclusive right to copy, distribute, and modify a thing, idea, or image. 
Copyright holders can give permission for others to copy, distribute, or modify their 
work when something has been copyrighted, it is considered intellectual property. (The 
date of publication is the date the published work became generally available.) The 
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length of time of a copyright is specific. In many cases, permission is not needed for 
education activities such as research and classroom use, but is required when you 
want to use someone else’s property for profit. 

Intellectual property is ideas, inventions, or processes that derive from the work of the 
mind, and the corresponding body laws, rights, and registrations relating to these 
properties. Intellectual property law grants certain exclusive rights to owners of 
intangible assets such as music, artistic works, discoveries, inventions, words, 
phrases, and designs. It includes the following protections: copyright, trademarks (a 
distinctive associated identifier), patents, design rights, and trade secrets. 

Fair use doctrine allows a user to make a copy of all or part of a work, even if 
permission had not been granted, for purposes such as criticism, news reporting, 
research, teaching, or scholarship. 

A derivative work is a new, original product that is based upon content from one or 
more previously existing works. 

So, can you use a picture you saw on a website in a class project? Yes. Can you use 
that same picture in a project for a paying client? No. Table 3 illustrates commonly 
used terms and an example of each. 

 

  

TABLE 3: COMMONLY USED IMAGE-USE TERMS 

TERM DEFINITION EXAMPLE 

Copyright Protection to an author of 
an original work, including 
the right to copy, 
distribute, and adapt that 
work. 

The author of a play 
(created after 1978) has 
copyright protection for 
his/her life + 70 years, 
after which the work 
passes into public 
domain. (The public 
domain indicates that 
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ownership of the work is 
public and can be used 
freely by anyone. 

Intellectual Property Refers to both the 
products of the mind and 
the accompanying legal 
protection for these 
intangible assets. 

Industrial icons such as 
the Nike swoosh, or the 
Lexus branding symbol. 

Fair Use Doctrine Conditions under which a 
work can be used without 
permission. 

An image based on a 
well-known scene in the 
film The Godfather that 
appears in a newspaper 
article. 

Derivative Work A new product created 
from an existing original 
product. 

The GIMP text book, 
which is based on the 
pre-existing GIMP 2.0 
book. 

  

Licensing Your Work with Creative Commons 
To many of us, the thought of dealing with lawyers or anything remotely legal makes us 
want to head for the hills. It is possible to license (and share) your work using licenses 
known as Creative Commons Licenses without the use of lawyers or expensive fees. 
Creative Commons (www.creativecommons.org) is a nonprofit organization devoted to 
making it easier for people to share and build upon the works of others by offering free 
licenses and legal tools with which to mark creative work. Using a Creative Commons 
License allows you to keep your copyright, while allowing others to copy and distribute 
your work. You determine the conditions: you may insist that you be credited, you can 
decide if you will permit commercial use of your work or if your work can be modified. 
Figure 7 shows the Creative Commons Licenses that can be applied to any work. The 
six licenses offered are then composed of combinations of license conditions, and 
consists of: 
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Attribution (cc by): The simplest of all Creative Commons licenses, in which any user 
(commercial or non-commercial) can distribute, modify, or enhance your work, provided 
you are credited. 

Attribution Share Alike (cc by-sa): The same as Attribution, except that the new 
owner must create their license under the same terms you used. 

Attribution No Derivatives (cc by-nd): Your work can be distributed by others, but not 
modified and in its entirety, with you being credited. 

Attribution Non-Commercial (cc by-nc): Your work can be distributed, modified, or 
enhanced, with credit to you, for non-commercial purposes only, but must be licensed 
under the identical terms. All derivative work must carry the same license, and be 
non-commercial. 

Attribution Non-Commercial No Derivatives (cc by-nc-nd): This is the most 
restrictive license category. Redistribution is allowed as long as credit is given. The 
work cannot be modified or used commercially. 

Figure 7 Creative Commons Licenses 

 

               ​  
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SKILLS REFERENCE 
  

TO DO THIS: USE THIS 
METHOD: 

Close a file Ctrl+W 

Create a new file Ctrl+N 

Exit GIMP Ctrl+Q 

Free Select Tool F 

Open a file Ctrl+O 

Save a file Ctrl+S 

Save As Shift+Ctrl+S 
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SKILLS REVIEW 
Start GIMP 
1. Start GIMP 

2.  Create a new image that is 500x600 pixels 

3. Save it as Review 

Open and save an image 
4. Open 1-3 from Student Key/Student Files/GIMP Ch. 1 

5. Save it as Rafting 

Examine the GIMP window 
6. Locate the image title bar and the current zoom percentage, then change the 

    padding color to theme 

7. Locate the menu you use to open an image 

8. View the Toolbox panel and the Tool Options panel 

Close a file and exit GIMP 
9. Close the Rafting file 

10. Close the Review file 

11. Exit GIMP 
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CHAPTER 2 
LEARNING GIMP BASICS 

  

Objectives: 

●​Use organizational and management features 
●​Use the Layers and History panels 
●​Learn about GIMP by using Help 
●​View and print an image 
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Working Magic with GIMP 
The essence of working with images in GIMP is based on an understanding of layers. 
Every image opened in GIMP is made up of one or more layers, and it is within these 
layers that you, as an artist, work your magic. The order of layers in an image, and the 
effects applied to them, can make one image very different from another. 

Learning to Love Layers 
Once you become more comfortable using GIMP, you’ll understand the importance of 
each of the panels. Some panels, such as the Layers panel, are vital to using GIMP. 
Since the layers are the key to creating and manipulating GIMP images, the Layers 
panel is one that we depend on most, for it tells us at-a-glance the order and type of 
layers within an image. And if the Layers panel is the map of the GIMP image, the 
History panel provides step-by-step instructions that let us know how we got to our 
destination. 

Finding Help when You Need It 
A complex program like GIMP needs a robust Help system. You’ll find that the Help 
system, which is accessed using your browser, doesn’t disappoint. Plus there are a ton 
of YouTube video tutorials that will also help you out. 

Viewing and Printing 
While not everyone prints each one to their images, nearly everyone needs to zoom in 
and out to get a better look at different areas. Using the Zoom tools, you can view the 
areas you need to focus on in as high or as low of a magnification as you want. If you 
do want to print out an image, GIMP offers great tools to do so.  
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Lesson 1 
USE ORGANIZATIONAL AND MANAGEMENT FEATURES 

  

Project Management and Complexity 
If you ask any client what they want in their project, they’ll most likely say something to 
the effect that they want it now, they want it done well, and they want it to not cost a lot. 
These three variables (performance, time, and cost) that are shown in Figure 8 
comprise the project scope and illustrate the complexity that exists in any project. 

●​ If the project is a low price and complete quickly, with the quality be satisfactory? 

●​ If the project is completed quickly and the quality is good, will the price be 
affordable? 

Ask the client, and they’ll say they want all three elements. But is this a realistic 
expectation. 

Figure 8 Project Complexity Triangle 
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Project Management Principles 
Project management is the execution of a plan that brings a project to a successful 
completion. No longer is project management as simple as saying “you do this’ and ‘I’ll 
do that’. A good project manager has to wear many hats and needs to have a thorough 
understanding of many elements, including budgetary requirements, client needs, 
production limitations, availability of supplies (industrial and human resources), 
identification of deliverables (such as specifications comps or sketches), and timeline 
management. Like an air traffic controller, a project manager must see what’s in front, 
off to the side, and just around the bend. 

Project management is not static: you don’t get it all formulated and then just let it sit. 
Good project management requires periodic revisiting and revision. Without this 
periodic review, a project may suffer from scope creep, a condition to be avoided in 
which a project seems to have lost its way. Communication review methods vary, but 
can and should include periodic peer reviews and surveys, and are important feedback 
measurements. Scope creep can lead to budget overruns and failure to bring a product 
to market in a timely fashion. All too often, a project can become a victim of its own 
planning. Since a project plan is writing down, many consider it to be “written in stone”. 
In fact, a project has so many opportunities to fall off the track: project members 
become ill, weather becomes a limiting factor, suppliers fail to deliver when promised, 
or the plan may have been ill-conceived. See Table 4 for some commonly used project 
management terms.  
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TABLE 4: COMMONLY USED PROJECT MANAGEMENT TERMS 

TERM DEFINITION EXAMPLE 

Project Scope The goals and objectives of the 
project. 

Creation of a website, including 
images. 

Tasks Specific goals that lead to the 
ultimate completion of the project 

Choose colors, collect photos, and 
creates logo. 

Due Dates When specific tasks must be 
completed in order to achieve the 

ultimate goal. 

Secure image permissions before 
website goes live. 

Resource 
Allocation 

How to best utilize resources, 
including budgetary constraints, 

human resources (including 
outsourcing), and supplies 

Ensure that image fees stay within 
budget and designer spends no 

more than 25% of her time. 
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Lesson 2 
USE THE LAYERS AND HISTORY PANEL 

 

You can think of layers in a GIMP image as individual sheets of clear plastic that are in 
a stack. It’s possible for your file to quickly accumulate dozens of layers. The Layers 
panel displays all the individual layers in an open file. You can use the Layers panel to 
create, copy, delete, display, hide, merge, lock, group, or reposition layers. 

Learning About Layers 
A layer is a section within an image that can be manipulated independently. Layers 
allow you to control individual elements within an image and create great dramatic 
effects and variations of the same image. Layers enable you to easily manipulate 
individual characteristics within an image. Each GIMP file has at least one layer, and 
can contain many individual layers, or groups of layers. 

In GIMP, using and understanding layers is the key to success. 

Understanding the Layers Panel 
The order in which the layers appear on the Layers panel matches the order in which 
they appear in the image; the top layer in the Layers panel is the top layer on the 
image. You can make a layer active by clicking its name on the Layers panel. When a 
layer is active, it is highlights on the Layers panel, and the name of the layer appears in 
parentheses in the image title bar. Only one layer can be active at a time. Figure 9 
shows an image with its Layers panel. Do you see that this image contains six layers? 
Each layer can be moved or modified individually on the panel to give a different effect 
to the overall image. If you look at the Layers panel, you’ll see that the GIMP type layer 
is blue indicating that it is currently active. 
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Get in the habit of shifting your eye from the image in the work area to the Layers 
panel. Knowing which layer is active will save you time and help you troubleshoot an 
image. 

Filtering Layers 
Layers can be filtered from within the Layers panel to build a short list of layers. This 
short list can be organized by Kind, Name, Effect, Mode, Attribute, or Color and can be 
created by clicking the Filter list arrow on the Layers panel. You can also filter layers 
using any of the five preset filtering buttons. 

Displaying and Hiding Layers 
You can use the Layers panel to control which layers are visible in an image. You can 
show or hide a layer by clicking the Indicates layer visibility button next to the layer 
thumbnail. When a layer is hidden, you are not able to merge it with another, select it, 
or print it. 

Hiding some layers can make it easier to focus on particular areas of an image. 

Using the History Panel 
GIMP records each task you complete in an image on the History panel. This record 
of events, called states, makes it easy to see what changes occurred and the tools or 
commands that you used to make the modifications. The History panel, shown in 
Figure 9, displays up to 20 states by default and automatically updates the list to 
display the most recently performed task. The list contains the name of the tool or 
command used to change the image you can delete a state on the History panel by 
selecting it and dragging it to the Delete current state button. Deleting a state is 
equivalent to using the Undo command. You can also use the History panel to create a 
new image from any state. 

When you delete a History state, you undo the state as well as all the events that 
followed the state. 
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Figure 9 Layers and History Panels 

 

Step Step-by-Step 2.1 
Hide and display a layer 

1.     Click File on the Menu bar, then click Open 

2.     Navigate to your Student Key/Student Files/GIMP Ch. 2/ 2-1, click Open 

3.     Save As: Wedding Day in Student Key/Gimp/Ch. 2 

4.     Click on the Rings Layer in the Layers panel 

5.     Click the Indicates Layer Visibility button 

Move a layer on the Layers panel and delete a state on the 

History Panel 
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1.     Click the Indicates Layer Visibility button on the Rings Layer 

2.     Click the EYE on the Hands Layer to hide the layer 

3.     Click and drag the Hands Layer on the layers panel beneath the Rings Layer 

4.     Click the Undo History Dialog Tab and at the bottom left of that panel click the 

yellow undo button 1 time 

5.     Click the Floppy to Re-Save 
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Lesson 3 
LEARN ABOUT GIMP BY USING HELP 

 

Understanding the Power of Help 
GIMP features a Help system that you can use to access definitions, explanations, and 
useful tips. Help information is displayed in a browser window, so you must have a web 
browser available to view the information. 

Using Help Topics 
The Home page of the GIMP help/Topics list displays detailed categories that you can 
use to retrieve information about GIMP commands and features. The following topics 
are available in the GIMP online pop out menu: 

●​ Developer Website 
●​ Main Website 
●​ Plug-in Registry 
●​ User Manual Website 

The following topics are available in the User Manual pop out menu: 

●​ Basic Concepts 
●​ Create, Open, & Save Files 
●​ Drawing Simple Objects 
●​ How to use dialogs 
●​ Preparing your Images for the Web 
●​ Using Paths 
●​ Working with Digital Camera Photos 
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When you click a link, GIMP Help takes you directly to the information you’ve selected. 
There will be a menu on the left of the web browser box and it will give you more Help 
options to choose from. 

Step Step-by-Step 2.2 
Find information in pop out menus 

1.     Click Help on the Menu bar, hover your mouse over User Manual, then click Basic 

Concepts. If a dialog box appears telling you to access the manual online, choose 

online. 

2.     Click the Plus Sign next to GNU Image Manipulation Program 

3.     Click the Plus Sign next to I. Getting Started 

4.     Click the Plus Sign next to 3. First Steps with Wilbur 

5.     Double Click 1. Basic Concepts 

6.     Close the GIMP Help Browser Window 

7.     Click the Floppy to Re-Save 

Understanding the Differences Between Monitor, 
Images, and Device Resolution 
Image resolution is determined by the number of pixels per inch (ppi) that are printed 
on a page. Pixel dimensions (the number of pixels along the height and width of a 
bitmap image) determine the amount of detail in tan image, while resolution controls 
the amount of space over stich the pixels are printed. Think of the differences between 
the picture quality on a standard-definition 480i television versus a high  definition 
1080i television. The high-definition image will be crisper and have more vibrant colors, 
whereas the standard definition image may look weak and washed out. High resolution 
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images shoe greater detail and more subtle color transitions that low resolution 
images. Lower resolution images can look grainy, like images in older newspapers. 

Device resolution or printer resolution is measured by the ink dots per inch (dpi) 
produced by printers. You can set the resolution of your computer monitor to determine 
the detail with which images will be displayed. Each monitor should be calibrated to 
describe how the monitor reproduces colors. Monitor calibration is one of the first 
things you should do because it determines whether your colors are being accurately 
represented, which in turn determines how accurately your output will match your 
design intentions. Screen Frequency, or line screen, is the number of printer dots of 
halftone cells per inch used to print grayscale images or color separations and is 
measured in lines per inch (lpi). Printer calibration ensures that what you see on your 
monitor is translated to paper.  
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Lesson 4 
VIEW AND PRINT AN IMAGE 

Getting a Closer Look 
When you edit an image in GIMP, it is important that you have a good view of the area 
on which you want to focus. GIMP has a variety of methods that allow you to enlarge or 
reduce your current view. You can use the Zoom tool by clicking the image to zoom in 
on (magnify the view) or zoom out of (reduce the view) areas of your image.  Zooming 
in or our enlarges or reduces your vie, not the actual image. The maximum zoom factor 
is 3200%. The current zoom percentage appears in the document’s status bar, in the 
bottom left of the screen and in the View menu. When the Zoom tool is selected, the 
options box provides additional choices. You can also change the zoom percentage 
using the navigator panel on the status bar by typing a new value in the Zoom text box, 
and then pressing Enter. 

Printing Your Image 
In many cases, a professional print shop might be the best option for printing a GIMP 
image to get the highest quality. Lacking a professional print shop, you can print a 
GIMP image using a standard black-and-white or color printer from within GIMP. The 
printed image will be a composite of all visible layers. The quality of your printer and 
paper will affect the appearance of your output. The Print dialog box displays options 
for printing, such as paper orientation. Orientation is the direction in which an image 
appears on the page. In Portrait Orientation, the image is printed with the shorter 
edges of the paper at the top and bottom. In Landscape Orientation, the image is 
printed with the longer edges of the paper at the top and bottom. 

Use the Print command when you want to print multiple copies of an image. The Print 
dialog box allows you to handle color values using color management and printer 
profiles. Use the Print One Copy command to print a single copy without making dialog 
box selections. 
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Printed images vs. on-screen images 
Why isn’t what you see on your computer screen the same as your printer output? 
Well, these two items are different because video monitors and printers work very 
differently. A printed image is measured in inches or centimeters, and its size is 
modified on paper by scaling. Also, an image size does not vary with its scanned 
resolution, and printed pixels are spaced using a specified scaled resolution. Image 
pixels are located at each screen pixel location. On screen, one screen pixel location 
contains one image pixel, and can be of any RGB value. 

Using the GIMP Image Info Dialog Box 
You can use the Image Info dialog box to identify a file, add a caption or other text, or 
add a copyright notice, as shown in Figure 10. 

  

         ​                               Figure 10 Image Info Dialog Box 

  

  

  

  

  

  

  

  

 

  

Using the Navigator Panel 
You can change the magnification factor of an image using the Navigator panel or the 
Zoom tool on the Tools panel. You can open the Navigator panel by clicking Window on 
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the Menu bar, and then clicking Navigator. By double-clicking the Zoom text box on the 
Navigator panel, you can enter a new magnification factor, and then press Enter. The 
magnification factor-shown as a percentage- is displayed in the lower-left corner of the 
Navigator panel. You can drag the proxy view area inside the Navigator panel to view 
other areas of the image at the current magnification factor. 

Step Step-by-Step 2.3 
Use the Zoom tool 

1. Click the Indicates layer visibility button on the Layers panel for the Rings Layer 

so the layer is no longer displayed. 

2. Click the Indicates layer visibility button on the Layer panel for the Hands layer so 

the layer is visible. 

3. Click the Zoom tool on the Tools panel. 

4. Position the Zoom in pointer over the center of the image. Press and hold down the 

Ctrl key on the keyboard and click the image twice. 

5. Release the Ctrl key. 

6. Change your Zoom percentage to 100%. 

Create a PDF file 

1. Click the File Menu, click Export As…, Find Student Key, GIMP, Ch. 2 

2. Delete everything that is in the Name Box. 

3. Type Wedding.pdf (no spaces) in the Name Box. 

4. At the bottom right of the box click the arrow next to the File Types box. 
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5. Scroll down the list. Locate and Click Portable Document Format (PDF). Then click 

the Export button at the bottom of the box. 

6. When the Export Image Dialog box pops up, click Export. 

  

  

SKILLS REFERENCE 
  

POWER USER SHORTCUTS 

TO DO THIS: USE THIS 
METHOD: 

Drag a Layer 
 

Hide a Layer 
 

Open Help F1 

Print File Ctrl+P 

Show a Layer 
 

Show History Panel Windows, 
Document 

History 
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Zoom Tool 
 

Zoom In Click on 
Picture 

Zoom Out Ctrl+Click on 
Picture 

  

SKILLS REVIEW 
Use the Layers and History Panel 
1. Open 2-2.xcf from Student Files 

2. Save as: Zenith Design Logo 

3. Drag the Wine Glasses Layer so it is above the Zenith layer, then use the Undo 
History Panel to undo the state. 

4. Use the Indicates Layer Visibility button to hide the Wine Glasses Layer. 

5. Make the Wine Glasses Layer visible again. 

6. Hide the Zenith Layer 

7. Show the Zenith Layer 

8. Show the Tag Line Layer 
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PROJECT BUILDER 
1. Open 2-3.xcf from Student Files 

2. Save as: Cooking 

3. Make the Measuring Spoons Layer visible. 

4. Drag the Oils Layer so the content appears behind the Skillet Layer content. 

5. Drag the Measuring Spoons Layer above the Skillet Layer 

6. Save the file.   
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CHAPTER 3 
REMOVING BACKGROUNDS & SAVING 

  

Objectives: 

●​ Adding Alpha Channels 
●​ Using Select Tools 
●​ Saving as JPEG & PNG  
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Removing Background 
You can use GIMP to remove backgrounds, objects and impurities from pictures. There 
are specific steps that you have to take to be able to do this 

Understanding the Importance of Adding an Alpha 
Channel 
Adding an Alpha Channel is the 1st step you have to take to be able to remove the 
background or an object from your picture. You have to make sure that your image is a 
JPEG or you have to save your image as a JPEG first before this option will be 
available for you to use. The Alpha Channel adds a transparent background to your 
image, so when you remove the object or background there will be absolutely nothing 
there. 

Using Layers to Modify an Image 
You can add, delete, and move layers in your image. You can also drag a portion of an 
image, called a selection, from one GIMP image to another. When you do this, a new 
layer is automatically created. Copying layers from one image to another makes it easy 
to transfer a complicated effect, a simple image, or a piece of type. In addition to being 
able to hide and display each layer, you can also change its opacity. Opacity is the 
ability to see through a layer so that layers beneath it are visible. The more opacity a 
layer has, the less see-through (transparent) it is. You can continuously change the 
overall appearance of your image by changing the order of your layers, until you 
achieve just the look you want. 

 

  

Lesson 1 
EXAMINE AND CONVERT LAYERS 
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Learning About the Layers Panel 
The Layers panel lists all the layers within a GIMP file and makes it possible for you to 
manipulate one or more layers. By default, this panel is located on the right side of the 
screen, but it can be moved to a new location by detaching the panel and dragging the 
panel’s tab. In some cases, the entire name of the layer might not appear on the panel. 
If a layer name is too long, an ellipsis appears, indicating that part of the name is 
hidden from view. You can view a layer’s entire name by holding the pointer over the 
name until the full name appears. The layer thumbnail appears to the left of the layer 
name and contains a miniature picture of the layer’s content, as shown in Figure 1. To 
the left of the layer thumbnail, you can add color, which you can use to easily identify 
layers. The Layers panel also contains common buttons, such as Delete layer button 
and the Create a new layer button. 

Recognizing Layer Types 
The Layers panel includes several types of layers: Backgrounds, type, adjustment, and 
image (non-type). The background layer whose name appears in italics – is always at 
the bottom of the stack. Type layers – layers that contain text – contain the type layer 
icon in the layer thumbnail, and image layers display a thumbnail of their contents. 
Adjustment layers, which affect the appearance layers, have a variety of thumbnails 
depending on the kind of adjustment. Along with dragging selections from one GIMP 
image to another , you can also drag objects created in other applications onto a GIMP 
image, which creates a layer containing the object you dragged from the other program 
window. 

QUICK TIP: It is not necessary for a GIMP image to have a Background layer. 
However, if you don’t have a Background layer, the background will take on the 
properties of all the layers and their opacities, which is more memory intensive than an 
object layer (a layer containing one of more images). 

Organizing Layers 
One of the benefits of using layers is that you can create different design effects by 
rearranging their order. Figure 2 contains the same layers as Figure 1, but they are 
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arranged differently. Did you notice that the yellow striped balloon is in front of both the 
black-striped balloon and the lighthouse balloon? This image was created by dragging 
the layer containing the yellow balloon (names Layer 2 on the Layers panel) above the 
Black striped balloon layer. When organizing layers, you may find it helpful to resize the 
Layers panel so you can see more layers within the image. 

Figure 1 Image with multiple layers  

  

   

Figure 2 Layers rearranged 

 

Converting Layers 
When you open an image created with a digital camera, you’ll notice that the entire 
image appears in the Background layer. The Background layer of any image is the 
initial layer and is always located at the bottom of the stack. You cannot change its 
position in the stack, nor can you change its opacity or lighten or darken its colors. You 
can, however, convert a Background layer into an image layer (non-type layer), and 
you can convert an image layer into a Background layer. You might want to convert a 
Background layer into an image layer so that you can use the full range of editing tools 
on the layer content. You might want to convert an image into a Background layer after 
you have made all you changes and want it to be the bottom layer in the stack. Note 
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that when you convert an image layer to a Background layer, you need to modify the 
image layer before converting it. 

Using Rulers and Changing Units of Measurement 
You can display horizontal and vertical rulers to help you better position elements. To 
display or hide rulers, click View on the Menu bar, and then click Rulers. (A check mark 
to the left of the Rulers command indicates that the rulers are displayed). 

In addition to displaying or hiding rulers, you can also choose from various units of 
measurement. Your choices include pixels, inches, centimeters, millimeters, points, 
picas, and percentages. Pixels, for example, display more tick marks and can make it 
easier to make tiny adjustments. You can change the units of measurement by clicking 
Edit on the Menu bar and clicking Units. In the Units Editor box, click the units you want 
to use then press Refresh. The easiest way to change units of measurement, however, 
is shown in Figure 3. Once the rulers are displayed on the status bar you can click the 
unit of measurement that you want. 

Pixel dimensions measure the number of pixels forming the width and height of an 
image, while resolution is the fineness of the detail in an image. The more pixels, the 
greater the resolution. 

Step Step-by-Step 3.1 
Convert an image layer into a background layer 

1. Click File on the Menu bar, then click Open 

2. Navigate to your Student Key/Student Files/GIMP Ch. 3/ 3-1, click Open 

3. Save As: Up in the air in Student Key/Gimp/Ch. 3 

TIP: If you receive a warning box about maximum compatibility or a message stating 

that some of the text layers need to be updated before they can be used for 

vector-based output, click Update and/or click OK. 
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4. Click View on the Menu bar, click Rulers if your rulers are not visible, then make 

sure that the rulers are displayed in pixels. 

TIP: If you are unsure which units of measurement are used, look down at the status 

bar to see what unit of measurement is being used. Choose Pixels if it’s not already 

selected.  

5. Click the Indicates Layer Visibility button 

Move a layer on the Layers panel and delete a state on the 

History Panel 

1. Click the Indicates Layer Visibility button on the Rings Layer 

2. Click the EYE on the Hands Layer to hide the layer 

3. Click and drag the Hands Layer on the layers panel beneath the Rings Layer 

4. Click the Undo History Dialog Tab and at the bottom left of that panel click the 

yellow undo button 1 time 

5. Click the Floppy to Re-Save 
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